
Literature 
Literature Management 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DDBST - Dortmund Data Bank Software & Separation Technology GmbH 

Marie-Curie-Straße 10 

D-26129 Oldenburg 

Tel.: +49 441 36 18 19 0 

Fax: +49 441 36 18 19 10 

support@ddbst.com 

www.ddbst.com

mailto:support@ddbst.de


DDB  2022 

DDB Literature  Page 2 of 30 

1 Starting DDB Literature .................................................................................................................... 4 
1.1 The Tool Bar ............................................................................................................................... 4 

1.2 The Menu ................................................................................................................................... 5 
1.2.1 The File Menu ..................................................................................................................... 5 

1.2.1.1 New Library ................................................................................................................. 5 
1.2.1.2 Open ............................................................................................................................. 5 
1.2.1.3 Close Library ............................................................................................................... 5 
1.2.1.4 Load Data Set Numbers ............................................................................................... 5 
1.2.1.5 Load Data Set Identifiers ............................................................................................. 5 

1.2.1.6 New Dataset ................................................................................................................. 6 
1.2.1.7 Import .......................................................................................................................... 6 
1.2.1.8 Delete Library .............................................................................................................. 6 
1.2.1.9 Rename Library ........................................................................................................... 6 
1.2.1.10 Extras ........................................................................................................................... 6 

1.2.1.11 Rebuild Index ............................................................................................................... 6 
1.2.1.12 Duplicate Search .......................................................................................................... 6 

1.2.1.13 Retrieve Keywords ...................................................................................................... 6 
1.2.1.14 External Links Settings ................................................................................................ 6 

1.2.1.15 Exit ............................................................................................................................... 7 
1.2.2 The Edit Menu .................................................................................................................... 7 

1.2.2.1 Global Options Page .................................................................................................... 8 

1.2.2.2 Result Window Options Page ...................................................................................... 9 
1.2.2.3 Import Options Page .................................................................................................. 10 

1.2.2.4 Environment Options Page ........................................................................................ 10 
1.2.3 The View Menu .................................................................................................................. 11 
1.2.4 The “?” Menu ..................................................................................................................... 11 

2 Searching ......................................................................................................................................... 12 

2.1 Quick Search ............................................................................................................................ 12 
2.2 Advanced Search ...................................................................................................................... 13 

2.2.1 Search fields ...................................................................................................................... 14 

2.2.1.1 String Fields ............................................................................................................... 14 
2.2.1.2 Number Range Fields ................................................................................................ 14 

2.2.1.3 Date Fields ................................................................................................................. 14 

2.2.1.4 Journal Field .............................................................................................................. 14 
2.2.1.5 Status.......................................................................................................................... 14 

2.2.2 Multiple Queries ............................................................................................................... 14 
3 Search Results ................................................................................................................................. 16 

3.1.1 Tool Bar ............................................................................................................................. 16 

3.1.2 Menus ................................................................................................................................ 17 

3.1.2.1 Results........................................................................................................................ 17 

3.1.2.2 Edit ............................................................................................................................. 17 
3.1.2.3 Search ........................................................................................................................ 18 
3.1.2.4 View ........................................................................................................................... 18 
3.1.2.5 Options ....................................................................................................................... 18 
3.1.2.6 Windows .................................................................................................................... 18 

3.1.3 Grid Functions................................................................................................................... 19 
3.1.3.1 Sorting........................................................................................................................ 19 
3.1.3.2 Column Moving ......................................................................................................... 19 

3.1.3.3 Context Menu ............................................................................................................ 19 



DDB  2022 

DDB Literature  Page 3 of 30 

3.1.3.4 List of Possible Columns ........................................................................................... 20 
4 Journals ........................................................................................................................................... 21 

4.1 Stored Fields ............................................................................................................................. 21 
4.2 Editing ...................................................................................................................................... 21 

4.3 Searching .................................................................................................................................. 22 
4.4 Selecting Journals ..................................................................................................................... 22 

5 Editing Single Sets .......................................................................................................................... 23 
5.1 List of Fields ............................................................................................................................. 23 
5.2 Tool Bar .................................................................................................................................... 26 

5.3 Special Command Buttons ....................................................................................................... 26 
5.4 Font Selection ........................................................................................................................... 27 
5.5 Displaying Externally Linked Files and Folders ...................................................................... 28 

6 Appendix ......................................................................................................................................... 29 
6.1 The Data Bank Structure .......................................................................................................... 29 

6.2 LEAR Tagged Format .............................................................................................................. 29 



DDB  2022 

DDB Literature  Page 4 of 30 

1 Starting DDB Literature 

 

 

DDB Literature is the literature management software of DDB. 

A fresh installed DDB Literature only contains a single database. It's the “DDBST” database containing all 

references for the DDBST data banks. 

The second database shown here is another “DDBST” database suffixed by a “/p”. This database contains all 

private references for customer-created data banks. Section The File Menu describes how to create a private 

literature database. 

DDB Literature handles also other – non-DDBST user-specific databases – they must not have the name 

“DDBST”. The status line displays the number of available datasets, the data and time of the latest write access 

of the database under the mouse cursor. In addition always the folder of the Dortmund Data Bank is displayed. 

When the mouse cursor is over a database icon the full path to the database file is displayed as hint. This also 

true when the option “Display Hints as Popup” in the “Global” part of the options menu is turned off. 

1.1 The Tool Bar 

 

The tool bar contains shortcuts to some functions. 

 

 Create a new and empty literature data bank (library) 

 Close a data bank 

 Append a new and empty data set to a selected library 

 Import another DDB Literature data bank 

 Search in library or libraries 

 Change display mode of data bank list 

 
Create a private library (only active if there is currently none) 
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1.2 The Menu 

1.2.1 The File Menu 

1.2.1.1 New Library  

ñNew Libraryò creates a new personal literature database. If the “private 

DDB” literature database does not exist it can be created using the first 

option. The second option creates a user specific database which can't be 

associated with experimental data like VLE.  

 

The database is always created in the “LITERAT” sub folder of the private DDB folder. 

 

This location is indicated by the “/p” suffix for ‘p’rivate folder. 

1.2.1.2 Open 

ñOpenò opens the currently selected data bank and displays the complete list of entries. The same happens when 

an icon is double-clicked. 

1.2.1.3 Close Library  

ñClose Libraryò is closing the database file stream but does not close any open result list. This allows to access 

the data base file from other tools. 

1.2.1.4 Load Data Set Numbers  

ñLoad Data Set Numbers...ò allows loading a file (STX format) that contains dataset numbers. These files can 

be created in DDB Literature – representing a search result – or in the main data bank retrieval program 

(“Dortmund Data Bank”) – containing all references of datasets in a query result. 

1.2.1.5 Load Data Set Identifiers  

This function is very similar to the previous function but the file to be opened contains additional information 

about the associated data base of the data set numbers. These files can be created in DDB Literature and can 

represent a search result from multiple data banks. 
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1.2.1.6 New Dataset  

ñNew Datasetò allows entering a new dataset. This is described later in detail. 

1.2.1.7 Import  

ñImportò allows adding data sets from other files and formats. 

The “REF” format is an old DDB format which has been superseded by DDB 

Literature and “Import LEAR” allows importing other DDB Literature data banks. 

1.2.1.8 Delete Library  

ñDelete Libraryò allows removing the selected database files – only the main “DDBST” library cannot be 

removed. A removed database cannot be restored. 

1.2.1.9 Rename Library  

 ñRename Libraryò allows changing the name of a data bank. The standard DDBST library – both private and 

public – cannot be renamed. 

1.2.1.10 Extras  

The “Extras” sub menu contains some utility functions. 

1.2.1.11 Rebuild Index  

ñRebuild Indexò recreates the DDB Literature indexes for a faster search. Normally the index is kept up to date 

automatically. 

1.2.1.12 Duplicate Search  

ñDuplicate Searchò allows finding duplicate 

entries. 

The ñDuplicate Search Options” dialog allows 

fine-tuning the criteria. The result of this search 

is a list with the duplicate entries which can be 

printed or copied.  

1.2.1.13 Retrieve Keywords  

ñRetrieve Keywordsò: Currently the list of 

available keywords is stored in the user specific 

part of the registry. This function adds all used 

keywords of the selected database to this list. 

1.2.1.14 External Links 
Settings  

The external links facility allows connecting 

scans, data files, PDFs etc. pp. with a reference in the literature database. Use the ñExternal Links Settingsò 

dialog to configure the folders where the associated files reside. 
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The folders can contain files of any type. The files must start with the associated literature dataset number. A 

leading “L” is as well allowed as leading zeros. Example: “1234.pdf”, “L1234.pdf”, “001234.pdf” and 

“L001234.pdf” will all refer to dataset number 1234. 

The external link settings are database specific. The usage of external links is described in section Displaying 
Externally Linked Files and Folders on page 28. 

1.2.1.15 Exit  

ñExitò closes DDB Literature and all open result windows. 

1.2.2 The Edit Menu 

ñSearch...ò opens the search dialog. Searching is described later in detail. 

ñJournals...ò opens the journal list. This dialog is described later in detail. 

ñOptions...ò displays the ñGlobal Optionsò dialog. 
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1.2.2.1 Global Options Page 

 

Hints are short descriptions of buttons. DDB Literature allows displaying these short help strings either as small 

popup windows at the mouse position or as strings in the status bar at the window bottom. 

The color options are for displaying two special literature types. 

 

“Ordered Literature” are articles and books that are in the process of being procured, “Exhausted Literature” are 

articles and books that cannot be procured, mainly because they are to old (19th century for example). 

“Translation Available Literature” are articles, which are available in another language. This applies mainly for 

Russian articles where an article translated to English is also stored. 

The colors are used as background color either in the single data set edit dialog or in the search result grid. 

The ñEnable External Linksò box has to be checked to associate external files to a data set. 
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1.2.2.2 Result Window Options Page 

 

Since sorting of larger search results is rather slow and memory-consuming DDB Literature allows to display a 

warning if the search result is larger. 

The options “Save Window Position” and “Save Window Size” are related to the search result window whereas 

the “Save Dataset Display Window Size and Position” is related to the details window, which can be opened in 

the search result. 

With ñUse Multi-Line Cellsò turned on the cells in the result list expand vertically to fit to the text in the cells. 

Otherwise all cells have the same high. This is for example useful to see the complete title in the result list. 

 

“Multi-Line Cells” turned off: 

 

“Multi-Line Cells” turned on: 

 

Data sets which status indicates that the articles are currently not available can be marked with a special color in 

the result list. Use ñStatus Colorò mode to modify the behavior. 

With ñKeep Horizontal Scrollò is turned on the result list does not jump to the first column when the keyboard is 
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used to navigate through the list. The option can lead to some flickering effects. 

“Show Setnumbers as Links” creates links from the data set numbers, which allow opening a single set by a 

single-click. 

 

 

1.2.2.3 Import Options Page 

 

Since DDB Literature allows importing literature information from multiple sources it is a major task not to 

import duplicates.  

The import options allow fine-tuning the search for duplicates. 

 

1.2.2.4 Environment Options Page 

The environment options are only displayed as additional information. 

The entries displayed here can be modified in the DDB configuration program. 
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1.2.3 The View Menu 

The entries “Normal, Small Iconsò, “List Viewò, and “Detailedò change 

the display of the libraries. 

Normal View: 

 

 

Detailed View: 

 

 

ñArrange Iconsò sorts the list of libraries and “Refreshò rebuilds the list. 

ñClose All Result Windowsò closes all result windows. 

1.2.4 The “?” Menu 

ñManual F1ò displays this PDF. 

ñAboutò displays detailed program version information. 
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2 Searching 

The search can be started from the   button in the main window. 

 

DDB Literature has implemented two search query modes – one simple and one complex. The simple search 

query is easier to handle but offers less options. It is possible to start with the simple query and copy the 

conditions to the complex query to refine the search conditions. 

2.1 Quick Search 

 

Available Fields are 

Authors Several names can be entered. The single names have to be separated by spaces. Only references 

where all names are given will be found (“And” relation). It is possible to specify that the word(s) 

can match anywhere in the authors list (substring), can only match as full word (whole word). The 

other options are not very useful and only for completeness. 

Years A single year or a range of years has to be entered. Any year must be specified with all four digits. 

A “/” can be used to define a continuous range, use “;” to separate single years. Example: To search 

for all literature published from 1980 to 1982 or in 1986 use “1980/1982; 1986”. 

First Page A single number has to be entered. Normally “exact match” is preferred, but it’s also possible to 

allow a match as “prefix”, “suffix”, or “substring”. 

Journal A list of numbers denoting the DDB journal numbers separated by blanks can be entered. Use the 

select button to select journals from the list. See below for details. 

Start 

Search 
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Volume Since volume can contain letters this search allows also a substring search. A search for “12” will 

also find “123” and “12A”. In addition all options as for “First Page” are possible. 

Title Several words can be entered. The single words have to be separated by spaces. Only titles with all 

words available will be found (“And” relation). Use “whole word” to find full words only. 

Numbers A range of data set numbers can be specified (format as in “Years”). In most cases this field is not 

used in combination with the other options. Therefore the field is marked slightly yellow when the 

content is not empty (to avoid unexpected search failures). 

 

The “*” denotes the fields for which DDB Literature has indexes. These searches are much faster than non-

indexed fields. The author’s index is not an exact index and will be not that efficient (=slower) than other 

indexes. 

The “Clear” button will empty all edit fields. The additional options are not touched. 

The ñCopy to Adv. Searchò button copies the current quick search settings to the advanced search settings. The 

advanced search page is active afterwards. 

The ñLibraries to be Searchò control contains all 

available literature databases. Only the selected 

databases are searched.  

2.2 Advanced Search 

 

The advanced search allows searching in almost all data fields (“Field” column). The “Mode” column contains 

options specific for the selected data fields. The “Operator” column allows (together the “String Mode” column) 
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to change the behavior of the search. The “Words” column contains the search text or number. 

2.2.1 Search fields 

2.2.1.1 String Fields  

String Fields are “Authors”, “Comment”, “First Page”, “Keywords”, 

“Language”, “Last Page”, “Location”, “Place/Inst.”, “Title”, “User defined 

Number”, “Volume”, “Issue”, “Report/Patent No.”, “First Editor”, “Last 

Editor”, “Series”, “Book Title”, “Series Name”. 

For String Fields the mode column has two options: “must contain” or 

“must not contain” and the operator column allows to search for “all” or 

“any” words in the words column. In addition it is possible to specify if a 

text must match as “substring”, “whole word”, “prefix”, “suffix” or “exact 

string”. The “Words” column accepts words separated by blanks. To search 

for text containing blanks enclose them in quotation marks. 

2.2.1.2 Number Range Fields  

Number Range Fields are “DDB Literature Number” and “Year”. It is 

possible to specify either one number and search for all which “is equal”, “is 

lower or equal” or “is greater or equal” or you can specify a number range 

(see quick search dialog for details). 

2.2.1.3 Date Fields  

Date Fields are “First Edit Date” and “Last Edit Date”. The “Words” 

column only accepts one valid date. Click on day, month, or year to change 

it. A click on the down arrow brings up a date selection dialog. It is possible 

to search for dates which are “equal”, “lower or equal” or “greater or equal”. 

2.2.1.4 Journal Field  

It is possible to search for (“must contain”) or exclude (must not contain) 

datasets from a list of journals. Use the button  to 

view/edit the selected journals. See section “Selecting journals” on page 22 

for details. 

2.2.1.5 Status  

The status of an article can be “available”, “missing”, “to be ordered”, “urgent demand”, “in process”, “can't be 

procured”, “not ordered” or “check needed”. The word column presents a pop up menu with the possible entries. 

2.2.2 Multiple Queries 

The advanced search dialog allows entering multiple search queries. 

 

 

 adds a new line, 
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 removes a line, 

 clears all query lines but leaves an empty initialized line (prepared for “Authors” 

search). 

Queries can be combined. 

 

¶ Either ALL query conditions must be fulfilled, or 

¶ ANY (one) query condition must be fulfilled, other conditions can be fulfilled. 

Use  to load and  to save a query. Queries are saved as INI files in a 

user specific folder. 

A click on the “Search” button will bring up the search result window (see next section). If 

nothing could be found the following dialog comes up: 

 

Click “Yes” to bring up the search query dialog again to refine the search option. It is also possible to add a new 

reference from this dialog. 
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3 Search Results 
After performing a search a query result window with all matches is displayed. 

 

3.1.1 Tool Bar 

 
Copy marked sets to the Windows clipboard in a publication format. 

 
Start email program (MAPI) with a new mail and the selected datasets as text file attachment (more 

than one entry selected) respective as text in mail body (one dataset selected). The default format is the 

publication format. To send the datasets in the display format click on the down arrow to get the 

menu item. 

 
Open a search query window. A search started from this place will perform a search in the given 

sub list. To search the full database either the full list must be active or switch back to the main 

window and start the search from there. 

 
This search doesn't read the data bank but 

only the grid content. 

The search result is not a new query result 

but the first grid line where the search item 

has been found will be selected. 

 
Search for a data set number within this result list. 

 
This function starts a search in the main data bank retrieval program for datasets of the marked 

references. 

 This function brings the main DDB Literature window to front. 
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3.1.2 Menus 

3.1.2.1 Results  

ñExportò allows saving the grid content either as comma-separated files or as an Excel- and OpenOffice-

compatible XLS files. 

  

ñExport Selectionò allows exporting the marked datasets either as a tagged text file or as a DDB Literature 

library. If an existing DDB Literature library is selected, the marked sets will be appended. 

 

ñSave Setnumbers...ò allows storing the DDB Literature dataset numbers only. Private references are stored as 

negative numbers. “Save Set Identifiers” stores the data set numbers together with their data base identification. 

See above for a description of ñSearch for Data of Selectionò. 

3.1.2.2 Edit  

 

ñCopy Selectionò allows copying the marked lines either in a 

publication format for use in text processor or in a grid format 

for use in spread sheets. 

ñEmail Selectionò allows sending the marked datasets either in 

publication or display format (see above). 

“New Dataset” opens the edit dialog and allows entering a new 

data set. This option is only available if the full list is active. 

ñModify Databaseò and ñDelete Selected Datasetsò allows removing data sets from the database. This 

command actually deletes the data sets in the database. It is not recoverable. Only references that are not 

used in the DDB can be removed. 

Use ñRename Result Windowò to give the result list a meaningful name. It is not possible to have two windows 

with the same name. Only the text between the brackets in the window title will change. Renaming the window 

makes it easier to identify a specific search result when switching between them using the ñWindowsò menu 

entry or the task bar entries (ñIndependent Windowò turned on). 
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3.1.2.3 Search  

 

The search functions have been explained in the tool bar section. 

3.1.2.4 View 

ñDetailed Displayò opens a child window with a detailed text view of the 

currently selected reference. The contents updates automatically when a 

different dataset is selected. 

The text in the ñDataset Displayò window can be printed and copied. It is possible to turn word wrap on an off 

and to set the window always on top. 

 

3.1.2.5 Options  

 ñEdit Optionsò displays the “Result Window” page of the global options dialog. 

 

3.1.2.6 Windows  

The ñWindowsò menu can be used to switch between several search results. This is useful if ñIndependent 

Windowò is turned off. 

 

 



DDB  2022 

DDB Literature  Page 19 of 30 

3.1.3 Grid Functions 

3.1.3.1 Sorting  

The grid allows opening an edit window for single set by double-clicking its line. Editing single sets is described 

in details elsewhere. 

The grid allows sorting its content by clicking in the first row. 

A second click on the same column reverts the sort order. 

Shift-click allows to sort by more than one criterion, like sort  

first by date and second by pages. 

 

3.1.3.2 Column Moving  

It is possible to change the order of the columns. This is done by clicking on the 

heading of a column, holding down the left mouse button while moving the 

mouse cursor along the heading to the left or to the right. 

 

3.1.3.3 Context Menu 

The context menu of the grid repeats several of the functions of the tool bar and the menu. The following 

functions are unique. 

 
ñChange Color of ...ò allows to select another background color for a 

column. 

 
A column can be removed from the result list. The only column that 

can't be removed is the ñNumberò column. 

 
Use ñInsert columnò to insert a hidden column into the result list. The 

column will be inserted before the column below the mouse cursor. 

 
ñRemove Selectionò allows removing datasets from the search result 

list. This does not modify the database. 

 
ñCreate New Window from Selectionò opens a new search result 

window with only the selected sets. 

 
ñCommon Propertiesò opens an edit window which allows to edit 

common properties of the selected data sets. 
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These “common” properties have to be the same in all selected datasets before editing; the different entries are 

inactive and cannot be changed. The only exceptions are “Keywords” and “Comment”. If the entries are 

different it is possible to choose to “append” a value to all selected datasets or to “replace” the value in all 

selected data sets by the specified value. “None” will leave the entries unchanged. The changes here modify 

the database. 

3.1.3.4 List of Possible Columns  

1. Number: Internal data set number 

2. Title 

3. Authors 

4. Publication Year 

5. Pages: First and last page separated by a 

hyphen 

6. First Page 

7. Last Page 

8. Volume 

9. Issue 

10. Journal 

11. Library: Name of the DDB Literature data 

bank 

12. External Files: Hyperlinks to external files 

if available  

13. ISSN: International Standard Serial Number 

14. CAS code of  Journal 

15. Journal Number: Internal DDB number of 

journal 

16. Keywords 

17. Language 

18. Place  



4 Journals 
The journal's editor can be started from the “Edit” menu of DDB Literature 's main window. 

 

 

DDB Literature uses an underlying journals list and provides an editor for this list. 

 

4.1 Stored Fields 

The most important fields in the journal list are 

¶ a journal number 

¶ a journal short name 

¶ the CAS source index 

¶ the ISSN number 

¶ a description of the type if the reference is not a journal. 

4.2 Editing 

The single entries are editable after selecting the ñEditò button. The ñMonograph Typeò can be easily 
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changed by choosing one item from the drop-down list. An empty field means “Journal”. 

Changed entries are marked red until they have been saved using the ñSaveò button. 

 

“Append” allows adding new journals. An empty row is appended to the journals grid and the grid is 

automatically in edit mode. By pressing the ñSaveò button the new journal can be used in the 

literature data bank. 

 The entire content of the journal’s list can be export to an Excel (‘*.xls’) file. 

4.3 Searching 

Searching for journals allows combining queries by simple logical operations. 

Search String Result 
eng&chem All journals containing “eng ” and “chem” are listed. 
eng|chem  All journals containing either “eng ” or “chem” are listed. 
eng&chem&!trans  All journals containing “eng ” and “chem” but not “trans ” are listed. 

 

Searching is always restricted to the currently listed journals. To search all journals the entire list can be made 

visible again by pressing the “Clear List” button. 

4.4 Selecting Journals 

The journals dialog is in selection mode when it is called from a search query window. 

 

In this case the dialog hides the ñEditò and ñAppendò buttons and activates the ñSelectò button. 

 

To select a single journal mark the grid line and press the ñSelectò button. It is also possible to select all marked 

journals by selecting one of the drop-down menu entries. 
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5 Editing Single Sets 
The editor for single sets can be called by either  

1. double-clicking a line or  

2. single-clicking on the data set number hyperlink in a search result or by 

3. adding a new dataset from the main window. 

 

5.1 List of Fields 

The list of fields changes with the type of paper (monograph, article, etc.). In the following the most important 

fields are described. 
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¶ Literature Kind Defines the type of paper stored. 

 

¶ Precise Kind 

For some kind of literature a more precise description is needed. This detail’s list 

contains a list of a more precise description of the reference kind. These lists are not 

complete and always contain an entry which can be used if nothing else matches (e. g. 

“monograph” for books). 

¶ Dataset Number A unique number specifying the data set. This number is automatically created by the 

program and cannot be altered. 

¶ User defined 

Number 

This is a freely definable number useful when another literature list has been imported in 

a DDB Literature library. It allows keeping the original numbering. 

¶ Title The title of the paper. 

¶ Authors The authors of the article. Each author has his or her own cell and the naming convention 

(for DDBST) data banks are family name followed by space and initials. The initials are 

not separated by blanks. 

The order of the authors can be changed by dragging the title bar to a different location. 

 

The context menu allows deleting a cell, merging two 

cells or inserting a cell. 

Press the ‘Return’ key in the last cell to append a new 

cell. 

A check function for authors is also available (see 

below). 

¶ Pages First page and last page of an article are stored in different fields. In case of an article 

from a book the first and last page should be used to denote the important pages. 

¶ Year Normally articles have only one year whereas data collections may have been published 

over a period. If there’s only one year given, this year should be entered in the ‘to’ field. 

 
 

The drop-down box shows the complete list of possible 

entries. Changing to another type changes the dialog 

controls, because the different types need their special 

descriptions. 

A list of these special controls is given in the 

following list. 
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¶ Institution/Place For theses and similar papers: A text field for further information on the authors, their 

institute or company. 

¶ Viniti Code For deposited documents: 

 

A “Viniti” is a specifically Russian and Ukrainian document type. It was and is common 

practice in the USSR and its successors that articles have been published only with their 

title and abstract. The rest of the paper with the experimental data is available from 

central libraries near Moscow and Kiev. 

¶ Patent No. Patent number, only used for patents. 

¶ WO No. Patent number, granted by the World Intellectual Property Organization, or WIPO. 

¶ Report Number Report number, only used for reports. 

¶ Journal 
  

The journal list is a separate file. DDB Literature only stores a number which is an index 

to the journal in the journals file. 

The journal can either be selected using the  button next to the journal name, by 

double-clicking in one of the grayed journal fields or by simply typing in the journal 

number left from the journal name. The journal selection dialog is described in section 

“Selecting Journals” on page 22. 

¶ ISSN International standard series number of a journal. This field belongs to the journal entry 

and can only be modified in the journal editor. 

¶ Volume Volume number of an article 

¶ Issue Issue number of an article 

¶ Series Series number or letter of an article 

¶ Book Title In article from a book “Title” contains the title of the article. “Book Title” can then 

contain the title for the whole book. 

¶ ISBN International standard book number (for books only) 

¶ Edition Edition of a book 

¶ Editor Editor of a book 

¶ Publisher / 

Place 

Name of the publisher (for book) or the place (for conference and thesis) 

¶ Language The original language of the paper (Chinese, Japanese, German, etc.) 

¶ Keywords DDB Literature manages keywords not as pure text, but as special list. This decision has 

been made for getting keywords organized. 



DDB  2022 

DDB Literature  Page 26 of 30 

 

The list contains also short terms for the different DDB data banks. 

¶ Entering Date Date of incorporation. This field is filled automatically and cannot be altered. 

¶ Location A text field for defining the location of the paper. 

¶ Comments This is a place for unstructured additional information. 

5.2 Tool Bar 

 
Copy dialog content to the clipboard (tagged format) 

 
Paste dialog content from the clipboard (tagged format) 

 Copy dialog content to the Windows clipboard – either in publication format or in 

display format 

 
Print dialog content 

 
Start main data bank retrieval program and display all datasets from current 

reference. 

 
Show external links (see below for details) 

 
Font selection (see below) 

5.3 Special Command Buttons 

  

The eyeglasses button besides the authors allows checking the author’s names order. The Google button starts a 

search in the registered web browser. 
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The   button calls a simple function for converting the title in uppercase/lowercase 

text. This function is far from perfect. 

Right-click the button to get a menu that allows also converting all to uppercase or all to 

lowercase. 

5.4 Font Selection 

The single set editor allows changing the font of the dialog's controls. 

 

Here's an example where the font is changed from Lucida Console 

 

to Arial. 
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5.5 Displaying Externally Linked Files and Folders 

The external links facility allows connecting scans, data files, PDFs etc. with a reference in the literature 

database. The dialog which displays the linked files and folders can be directly displayed from within the single 

dataset editor. If the connection symbol  is enabled there are files associated with the current dataset. 

 

The link display dialog displays the linked files and folders. Double-click on a file name or click “Open File” to 

load the document into the registered application. Double-click on a folder name (or a click on “Open Folder”) 

to see the full folder contents. 

 

Section ñExternal links settingsò on page 6 describes how to configure the folders for external files. 
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6 Appendix 

6.1 The Data Bank Structure 

 

DDB Literature has been designed to support multiple libraries; two of these libraries have special meanings. 

The DDB system supports two data banks, a public and private data bank. These are normally located in two 

different folders. DDB Literature uses this organization and supports a private and a public literature data bank. 

A private data bank is intended for use by our customers to store company owned data and literature. The public 

data bank is distributed by DDBST GmbH. 

6.2 LEAR Tagged Format 

The tagged format (ASCII) is used for example when a single dataset is copied to the clipboard. The defined tags 

are: 

Tag Meaning 

SET: Data set number 

CLA: List of links in the format DDB-short-term (HE for mixing enthalpies in the example) followed by the 

link number in square brackets. If there are more links each are separated by blanks. 

AUT: Authors 

TIT: Title 

DCL: Journal class 

JRC: Journal number (from the DDB journals list) 

JRN: Journal short name 

JCS: Journal code (CAS source index) 

JLT: Journal long name 

LNG: Language 

PNR: Patent number 

 DDB.CFG 

Public Folder 

Public folder 
location location 

Private folder 

Private Folder 

Public Literature 
Folder 

Private 
Literature Folder 
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Tag Meaning 

YEA: Year 

PGE: First and last page separated by blank 

VOL: Volume 

SER: Series 

ISS: Issue 

PLC: Place 

BTI: Book title 

EDI: Edition 

ISB: ISBN 

SNA: Series name 

ENA: Editor name 

CMT: Comment 

UDN: User defined number 

KWD: Keywords 

EDA: First edit date 

CRE: First editor 

LOC: Internal location 

STA: Status 

LDA: Last edit date 

LED: Last editor 

DOI: Document object identifier or web link 

VER: Format version 

PWO: Patent WO number 

 


